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ECLIPSE - Une courte introduction Historique

1 Historique

En Novembre 2001, IBM et sept autres compagnies lancent Eclipse comme projet « Open
Source». Le succes dépasse tous les espoirs des fondateurs. L'ensemble des nombreuses
compagnies qui a rejoint Eclipse est organise en une corporation & but non lucratif: « Eclipse
Foundation ».

Initialement Eclipse permet de développer des Environnement de Développement de Logiciel
(Integrated Development Environment, IDE) pour de nombreux langages: C, C++, Python, Ruby,
et bien sur Java

Cette plateforme, qui a fait ses preuves, est mise a la disposition des développeurs pour réaliser des
outils de dével oppement et toutes sortes d'applications.

Eclipse fournit des éditeurs, des constructeurs, des débogueurs , des outils permettant de gérer le
développement en équipes, ... .

De nombreux projets développé sur la plateforme Eclipse voient le jour.

1.1 Les versions
Tous les ans début juillet apparait une nouvelle version d'Eclipse. Chaque version porte un nom:

MCours.com
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2 Notions de base

Eclipse n'est pas un logiciel monolithique mais un petit noyau « plug-in loader » entouré de
centaines de plug-ins. Un plug-ins peut attendre un service d'un autre plug-in ou fournir un service a
d'autres plug-ins.

2.1 Les plug-ins

Le comportement d'un plug-in est défini par son code mais ses dépendances et ses services sont
déclarées dans deux fichiers « MANIFEST.MF » et « plugin.xml ».

Au lancement d'Eclipse, le «plug-in loader » analyse les fichiers « MANIFEST.MF » et
« plugin.xml ». Pour chaque plug-in il construit une structure contenant cette information. On évite
ainsi de charger I'ensemble du code des « plug-in » et donc d' écrouler la plateforme.

Un plug-in est construit par gout de points d'extensions (Extension Points) qui sont des références a
d'autre plug-ins. Le fichier « plugin.xml » mémorise |les points d'extensions du plug-in.

2.2 Le «Workspace »

Eclipse affiche et modifie les fichiers du « Workspace ». Le « Workspace » contient les fichiers
utilisateur et des fichiers nécessaires a Eclipse.

2.3 Le « Workbench »
Le « Workbench » fournit un ensemble de fonctions homogenes :
pour lacréation et le « management » des ressources du « Workspace »
la navigation dans les ressources du « Workspace ».

Lors du lancement dEclipse un boite de dialogue permet de préciser |'emplacement du
« Workspace ».
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Dans le cas du développement d'un « plug-in » I'interface utilisateur al'aspect suivant:

Perspective bar

A . <= Plug-in Devel. ..

Mk morProjet 52 =0

s

=5 Tl & overview 0 ¥

= 'bd manPrajet
BB, IRE System Library [Javase-1.6] General Information Plug-in Content

; | Plug-in Dependencies This section describes general information about this
8 sre plug-in. The content of the plug-in is made up of bwo secti
=83 monprojet D Froiet ﬁ Dependencies : lists all the plug-ins required ¢
m Activator.java . manfroje - plug-in's classpath to compile and run.
= META-INF Versian: l.D.D.q.uaI\Fler @y Runtime : lisks the libraries that make up this |
B MAMIFEST MF Mame: MonPraojet in's runtime.

= X Provider: LAAS CNRS
: B build. properties )
Flatform Filker: Extension / Extension Point Content

Activatar: ronprojet. Activatar W —
Brol - This plug-in may define extensions and extension

Activate this plug-in when one of its classes is loaded Iél"? Extensions: declares contributions this plug-i
makes to the platform.

O this plug-in is a singleton
ﬁ Extension Poinks: declares new function poin
plug-in adds ta the platform,
Execution Environments
Specify the minimum execution environments required to
run this plug-in. Testing

‘ =) JavaSE-1.6 | | add... | Teslf this plug-in by launching a separate Eclipse
i i _I
»

<

Overview] Dependencies | Runtime | Extensions | Extension Paints | Euild | MAMIFEST.MF | build. properties |

Lrogdress area

Toutes les actions de I'l nterface Utilisateur sont accessibles depuis le « menu bar »

Le «toolbar » est un ensemble d'icones qui permet d'accéder a certaines commandes des
menus du « menu bar »

Un « Editor » permet de visualiser et de modifier lesfichiers du « Workspace ».

Un Editeur apparait au centre du « Workbench ». Ici |'éditeur est le « Plug-in Manifest
Editor » qui joue un réle primordial dans la création des plug-ins.

Une «view » affiche selon un point de vue particulier une information. Ici le « Package
Explorer » permet de naviguer dans le « Workspace »

Une per spective définie et positionne différentes vues autour de |'éditeur.

La perspective sélectionnée est ici la perspective « Plug-in Development ». Elle définit et
positionne I'éditeur et les vues qui constitue |'environnement de dével oppement particulier.

Pour naviguer dans le projet on utilise le « Package Explorer view ».

Par exemple, un double clic sur le fichier « META-INF/ MANIFEST.MF » ouvre le « Plug-
in Manifest Editor ».

La « Fast view bar » permet d'accéder rapidement a une vue.
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2.4 La plateforme « Software Development Kit »
Lafigure ci-dessous décrit le « Sofwar e Developement Kit » (SDK):

Java Plug-in Eclipse
Development || Development SDK New
Toolkit Environment » [Plug-in

e

Eclipse Plateform

Workbench Help
= Workspace
SWT ace Team

Platform runtime

Nous allons définir chague module.

2.4.1 « Eclipse plateform »

La plate-forme Eclipse est organisée en sous systemes qui sont implémentés sous la forme d'un ou
de plusieurs plug-ins. Les sous systemes sont construits sur la « Plateform Runtime ».

L es sous systemes.

SWT - «Standard Widget Toolkit» Une librarie de widgets destiné a la construction
d'interface utilisateur. Ces widgets sont étroitement intégrés au systeme d'expl oitation.

JFace — Une librairie générale construite au dessus de SWT.
Workbench constitué de:
Workbench Core — assure entre autre la gestion des projets

Workbench Ul — géré les aspects Interface Utilisateur (éditeur, vue, perspectives,
actions, préférences)

Team — groupe de plug-ins pour intégrer des outils comme (CVS)
Help - Permet de développer une documentation intégrée a l'Interface Utilisateur.

2.4.2 « Java Developpement Toolkit »
Java Development Toolkit est constitué de:
JDT core — Plug-ins pour le Java Developpement Tooling (hors Ul)
JDT — plug-in pour Eclipse IDE.
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Notions de base

2.4.3

« Plug in development environment »

Environnement de dével oppement de « plug-in » utilisé lors du développement de nos plug-ins.

24.4 OSGI

Le mécanismes des plug-in Eclipse est basé sur la notion de « bundles» normalisé par « OSGI
Alliance », voir « http://www.0sgi.org/.

Le terme «Bundle» est parfois utilisé a la place de «plug-in». Par exemple dans le fichier

« MANIFEST.MF » :

Manifest-Version: 1.0

Bundle-ManifestVersion:

Bundle-Name: MonProjet

2

2.5 Les « Preferences »
Afin d'adapter la plateforme Eclipse a nos besoins on dispose d'un ensemble de préférences.

Séectionner lacommande: « Window > Preferences »

=
L1

File Edit Source Refactor Mavigate Search Project Run Sample Menu

SIF-0-A-|EHEG-|BE 5

& Plug-in Development - org.eclipse.salut/src/monCode /HandlerBonjour.java - Eclipse

Help

Tew Window
INews Editar

i Package Ex &3 %Plug—inq =0 -@mg.eclipse.salut I,m Han
HE&E|e T = /e

=] '[ad org.eclipse,salut
[¥l-E, JRE System Libraty [JavasE-1.6]
#-B, Plug-in Dependencies

E@ Sre

F3 monCode

; m HandlerBonjour . java
m HandlerHella,java
F3 org.edipse. salut

B icons

175, MET A TME

Open Perspective
Show Wiew

* the command
* from the ap

=
= public Chject
IWorkhench
MessageDig

Custamize Perspective. .
Save Perspective As...

Reset Perspective...
Close Perspective
Close All Perspectives

i

Mavigakion

ey
"E

Preferences

return null;
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Par exemple les valeurs ci-dessous seront utilisées par le « New Java Project création wizard »

_lo/x]

|type filter ket Build Path =l T
-G |
H Enera = Specify the build path entries used as default by the Mew Java Project creation
[l Ank wizard:

elp
B InstallfUpdate Source and output Folder

- Java  Project
- Appearance

& Folders

Code Style Source Folder name: I srC
Compiler
[- Debug e Qukput Folder narme: | bir

[+ Editor
Installed JREs
Ik

- Properties Files Editor - | |
e . Restore Defaults Apply
al I_>I_I 3

#s JRE library use: IJRE conkainer j

® ok I Zancel |

C 'est adirelors delacréation d'un nouveau projet Java.
Il est aussi possible de définir notre propre page de préférences afin d'initialiser notre application:

& preferences _ ol x|
Itype filter bext Mes Preferences = T
- General - . i
B Ant Mettre & jour les champs suivants.
[+ Help Repertoire de test: I E:\RepertoireDeTest Erowse. .. |
(- InstalliUpdate -
i Mo du Fichier | Corréze, bxk
[F- Java

- e efed Contenu du Fichier | La Corréze est un département du Limousin,
- Plug-in Development
- Run/Debug

- Tasks

- Team LI Restore Defaulks | Apply |

firn s Brw
(R Rk d R k)

® Ok I Cancel |
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3 Eclipse packages

Nous avons vu que la principale caractéristique d'éclipse est sa modularité. La fondation Eclipse
fournie différents ensembles de plug-in pour répondre a des besoins particuliers, par exemple:

« |IDEC++, ...
«  Plug-in developers,
- €lC...

3.1 Packages standards

Pour éviter tout probléme dincompatibilité entre différentes versions de plug-ins vous trouverez des
packages tout prét (http://www.eclipse.org/downloads/), faite le bon choix!

3.1.1 IDE:
Des Environnement de développement intégrés pour développer des applications:
Java

Eclipse IDE for Java EE Developers

Package Details

Taools for Java developers creating Java EE and Web applications, including a Java
IDE, tools for Java EE, JPA, J5F, Myhyn and others.

& Eclipse Classic 3.7

Package Details

The classic Eclipse download: the Eclipse Platform, Java Development Tools, and
Plug-in Development Envirenment, incleding source and both user and programmser
documentation. Please look also at the Eclipse Project download page.

CIC++:

@+ Eclipse IDE for C/C++ Developers
components)

Package Details

An |IDE for C/C++ developers with Myhyn integration. Mote that this package
includes some incubating components, as indicated by features with “{Incubation)”
following their name.

CNRS - LAAS - 2| — Serge Bachmann Page 10/19



ECLIPSE - Une courte introduction Eclipse packages

3.1.2 Developpement de plug-ins
Pour développer des plug-ins on pourra utiliser:
- Déveoppement de plug-ins:

- Eclipse for RCP and RAP Developers

Package Details
A complete set of tools for developers who want to create Eclipse plug-ins, Rich

Client or Rich Ajax Applications (RCP+RAP), plus Myhyn, and an XML editor. In
addition to the CW'5 Eclipse Team provider, it also contains the EGit tooling for

accessing Git version control systems.

ce « package » permet:
- dedévelopper de nouveaux plug-ins.

- de développer des applications Eclipse RCP (Rich Client Platform) qui
sexécutent indépendamment d'une plate-forme Eclipse.

- Développement de plug-ins a partir de méta-modele:

& Eclipse Modeling Tools

Package Details
This package contains framework and tools to leverage models : an Ecore graphical
madeler (class-like diagram), Java code generation utility for RCP applications and

the EMF Framework, model comparison support, support for X500 schemas, OCL
and graphical modeler runtimes. [t incledes a complete SDK, developer tools and

SOUNCE Code.

3.2 Package configuré sur mesure
Pour réaliser une configuration sur mesure utilisez le site:
http://ondemand.yoxos.com/geteclipse/start

CNRS - LAAS - 2| — Serge Bachmann Page 11/19



ECLIPSE - Une courte introduction

Quelques trucs et astuces

4 Quelques trucs et astuces

4.1 Pour connaitre la version d'Eclipse utilisée
Sélectionner la commande « Help > About Eclipse »

I'ch -

| ® |- |@e s

P
rﬁ_ﬁ Project Explarer

EE"\K

E=

| -

=

-l exemple.graphe
L:J exemple,graphe. emf

:L:‘,J- exemple. graphe.emf . edit
:L:‘J exemple. graphe.emf . editar
L:‘J exemple. graphe. emf tasts

on obtient:

& About Eclipse

Eclipse Modeling Tools

Yersion: Indigo Release
Build id: 20110615-0604

Wisit bttp: ffedlipse. orgf

& Ecore - Eclipse

File Edit Mavigate Search Project Run  Window

SE
(i) relcome

(7) Help Contents
1 Search
Crymarnic Help

ke Assist,. . Ckrl+Shift+L
Tips and Tricks. ..
ﬁ Repart Bug or Enhancement. ..

Cheat sheets. ..

Check for Updates
Install Mew Software, ..

o Install Modeling Components
Eclipse Marketplace. ..

About Eclipse

=10l x|

(] Copyright Eclipse contributars and athers 2000, 2011, All rights reserved,

This product includes software developed by the
Apache Software Foundation bttp: [/fapache,org)

%

-

Se

@:.l Installation Details |
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Quelques trucs et astuces

4.2 Pour connaitre les plug-ins installés

Dans la fenétre « About Eclipse » (voir paragraphe préceédent) cliquer « Installation Details ». Dans
« Eclipse Installation Details » cliquer « Plug-ins » pour afficher laliste des plugins.

En cliquant dans « Plug-in Id » on trie les plugins par ordre alphabetique (ou I'ordre inverse):

& Eclipse Installation Details 100 x|
Installed Software I Installation History: I Features Flug-ins IConFiguration I
Sid. .. | Provider | Flug-in Mame | ‘Wersion | Flug-inId = :l
IBM Corporation | International Components for Unicode For Java (ICU41)  4.4.2,v20110203 com.ibm.icu e
JCraft, Inc. Jsch 0.1.41.%201101211617  com.jcraft.jsch
Eclipse.arg Rss and atCM utilitiEs (ROME) 0.9.0,v200803061811  com.sun.syndication
Eclipse Crbit Apache Geronima Activation Plug-in 1.1.0,w201108011116 | jawvax.ackivation
Eclipse.arg Servlet API Bundle 2.5.0,v201103041518 | javax.serviet
Eclipse.arg Java Server Pages API Bundle 2.0.0w201101211617  javax.servlet.jsp
Eclipse Crbit JAWP ML 1.3.4,v201005030400 | javawx.xml
@1 Colimmm Ciekik VhAL DimAdima Foe Tema- DO I AN T AD i amns nemml e il
1 | »
@:I Legal Info Shiow Signing Infa Colurmns., .. |

4.3 Pour connaitre le « Workspace » en cours d'utilisation
Séectionner:« File > Switch Workspace > Other... »

&= Plug-in Development - PlugInWithEditor /META-INF/MANIFEST.MF - Eclipse SDH

Edit Mavigate Search Project Run  Window Help

T . Alk+Shift+r B 2 | o e o _

Cpen File, ..

Close Chrl+i

Clase Al Curlsshifeoy  fotar &8 \___m EAlr

Save (o sions

SEVEIAS, ..

Save &l Cl+shiftes M8 il =

Rewerk sions For this phug-in

ng seckion,

ave, ..

Remame. .. F2 £

Refresh F5

Convert Line Delimiters To 4

Frimt. .. ChrlHE

Switch Wo ENFORMATIONECLIF

Reskart E:\FORMATION|ECLIF

E:FORMATIONIECLIF

23 Impart.., [ EH\FORMATIOMIECLIF
£ Export..., e

Properties Alt+Enter %

1 VM PvecnirnenbDrmidar izos TOh AT 1

Dans « Workspace Launcher — Select a wor kspace » le workspace courant est visualise:
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& wWorkspace Launcher LI

Select a workspace

Eclipse SDK stares your prajects in a Folder called a workspace.,
Choose a workspace Folder to use For this session.

FORMATIONECLIPSE )Y

2k SPACELPlugInwithanEditar

Erowse... |

‘workspace:

» Copy Settings

@) Ok I Cancel

Cliquer « Cancel »

4.4 Modification directe dans le « Workspace »

Bien que cette pratique soit peu orthodoxe, il peut ére commode d'éditer, par exemple, un icone
directement dans le « Workspace ».

Moyennant quelques précautions, on peut intervenir directement dans le « Workspace », il est
cependant préférable de créer au préalable les fichiers avec les commandes Eclipse.

Dans le cas ou il y a divergence entre Eclipse et le contenu du «workspace» un message
« Ressource isout of sync with the file system: nom de laressource » saffiche.

Faire un clic droit sur la ressource dans le « package explorer » et sélectionner dans le menu
contextuel |la commande:

J o Refresh

MCours.com
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Documentation

5 Documentation

5.1 Documentation sur un point d'extension

Lors de la creation d'un point d'extension dans « New Extension — Extension Point Selection » une
description du plug-in est donnée. Eventuellement un « template » est fourni.

1ol x|

Extension Point Selection

Create a new exkension From the "Hello, World" command contribution template, -D —

Extension Points | Extension Wizards I

Extension Point Filker: | commands

fj’org.eclipse.ui.commands

¥ Show only extension points from the required plug-ins

Extension Point Description: Commands

The org.eclipse.ui.commands extension point is used to declare commands
and command categories, using the q:\:g\:mand and category elements. A
command is an abstract representatiod of some semantic behaviour, but not it's
actual implementation. This allows different developers to contribute specific
hehawvinur far their individoal narts For exyamnle there minht he 2 "nacta™

Available kemplates For commands:

[

"Hella, Warld" command contribution This template creates a simple command
contribution that adds Sample Menu to tt
meny bar and a button to the kool bar, Bott

the menu ikermn in the new menu and the -
Al | ]

s

@ = Back I Mext = I Fimish I Cancel

Pour comprendre |e fonctionnement d'un point d'extension on peut sélectionner un « template ».

5.2 Documentation en ligne
Sélectionner « Help > Help Contents »:

File Edit Source Refactor HMawigate Search Projeck Run Sample Menu  Window

& Plug-in Development - monProjet/META-INF/MANIFEST.MF - Eclipse

I T~ |3 -0 - Q- | BH G- |®S - | @ @k
J & &) Help Contents
ﬂ:g Package Explorer 3 %F‘Iug-inﬂ = Eq(.@ morProjet B3 2] Eeﬁr_-:_h.
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Documentation

Ladocumentation en ligne saffiche:

Search: |

& Help - Eclipse

| m Search scope: All topics

=181

Conter i =y~ | 7 = [E] O

oo fr | ® oefl 2 O

= Eﬂ] ‘Workbench User Guide
B Edipse platform ove
[ Getting started
[ concepts
[ Tasks
[ Reference
B Tips and tricks
El what's new
] Legal
@ Java development user guide
@ platform Plug-in Developer Guid
©* 1DT Plug-in Developer Guide
@ Plug-in Development Environme
@ Mylyn WikiText User Guide
@ Notre documentation
@ Tasks User Guide
L3 Usage Data Collector

Workbench User Guide =

Eclipse platform overview N

The Eclipse platform itself is structured as subsystems which are implemented in
one or more phig-ins. The subsystems are built on top of a small runtime engine.
The figure below depicts a simplified view.

-

('-El:lipse Platform

Workbench Help ™

JFace

Workspace

Il est possible de réaliser une recherche:

& Help - Eclipse

| m Search scope: All topics

Search: Handler

=10l x|

Search Results

¢ = 5] o

[Hle= @lg+lea

A handler is the implementation of a command's
behaviour. Any plugin can contribute a handler
implementation for any command. The workbench uses
core expressions and progra...

B Handlers
org.edipse.ui.handlers Since: 3.1 Description: The
handlers extension point is an elaboration of the
experimental handlerSubmission element defined in
Edipze 3.0. A handl...

B status handlers

org. edipse.ui.statusHandlers Since: 3.3 Description:

of status handlers in the workbench. A handler can be
a580Cia. ..

[ splash Handlers

org.edipse.ui.splashHandlers Since: Since 3.3
Description: This extension point allows for the

may contribute custom...

b B

e
B Handlers

This extension point is used to register implementations

contribution of splash handlers. These splash handlers

o

FY

Platform Plug-in Developer Guide = Programmer's Guide > Plugging into the workbench > 2]
Basic workbench extension peints using commands

Handlerd

A [P is the implementation of a command's behaviour. Any phigin
can contribute a implementation for any command. The
workbench uses core expressions and programmatic scoping rules to
determine which is active at any time. There can either be one
acl:ive the comaj}d__ornosa.cﬁveforthe command
(the command is effectively disabled). When the command has an active
: we say the command is handled.

Associating a defanlt m with a command

1

Tn'n'lp there ic a chortent for a -"IF'rHIII'I m minst mca are _ILI
»
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Ou d'obtenir I'ensemble des « APl » dans
« Platform Plug-in Developer Guide > Reference> APl Reference »

il
Search: Handler |m Search scope: All topics
Contents ¢ =+ 2[Ela o frlw sl o0

@ Workbench User Guide 21| Platform Plug-in Developer Guide > Reference > API Reference =1
@ Java development user guide b
= ['3_J| Platform Plug-in Developer Guide

(3 Programmer's Guide Overview L& ELE] Class Use Tree Deprecated Index He—
=l [ peference
=) [ AP Reference PREV PACKAGE NEXT PQKAGE FRAMES NO FRAMES

B org.edipse.ant.core

B org.edipse.compare
B org. edipse. compare, contentmergeviewer

Bl org.edipse.compare.patch Package org.eclipse.ant.core
E org.edipse.compare.rangedifferencer
El org.edipse.compare.structuremergeviewer Provides support for mmnning the Ant build tool in the platform.
E org.edipse.core.commands
El org.edipse. core.commands. comman See:
[ B org.edipse.core.commands.coniiexts _lﬂ Description
4 4

B | B v | @ « | ;ILI

Remarque: 1l ne faut pas chercher a programmer directement a partir de la définition d'une API
mais a partir d'exemples d'utilisation de |I'API!

5.3 D'autres sources
Plusieurs sources sont a votre disposition.
Sous Eclipse en cour s de développement
«  Ladocumentation sur un point d'extension
- Ladocumentation en ligne
- L'aidefournie par les éditeurs
Hors plateforme Eclipse
« Lessitesdont le site officiel:
http://www.eclipse.org/

- The Eclipse Seriesinformit.com/series/eclipse
eclipse Plug-ins (third Edition)
eclipse Modeling Framework (Second Edition)
eclipse Rich Client Platform (Second Edition)
eclipse Modeling Project

Coursde«LarsVoge »
- http://www.vogella.de/eclipse.html
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6 Différentes utilisation d'Eclipse

Il existe bien des facons dutiliser Eclipse. Dans |'ensemble des documents proposés nous allons
aborder, atravers des exemples, les points suivants:

L'utilisation de I'environnement de développement intégré Java,

L e développement de plug-ins, les notions de base,

L e développement d'applications indépendantes,

Lagénération de plug-ins a partir de Méta-modeles,

La génération d'éditeurs syntaxiques coloré adaptés a un langage spécifique a un domaine.
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7 Conclusions

Quelques notions de bases on étaient rapidement exposées. Le lecteur se reportera aux différentes
sources citées pour compléter ses connai ssances.

8 Licence

Lalicence « créative commons » : http://creativecommons.org/licenses/by-nc-nd/2.0/fr/

sappligue a ce document.

@080

Ze decuments rédigés par Serge Bachimann est mis & disposition selon les termes de la
licence Creattve Commeons Patermité-Fas J Tihisation Commerciale-Pas de
IModification 2.0 France.

FPour toute précision s'adresser & « bachi@laas fr »
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